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IMPORTANT Information

1. The Energy Commission system does not delete or remove documents once they
have been accepted (docketed) by the system. Check your document carefully before
submitting your document to the system.

2. Contact Information: docket@energy.ca.gov
Docket is available during business hours: 8am-5pm, Monday — Friday, closed most
Federal and State Holidays.
E-Filing Confidential Documents

1. To submit a confidential filing, click on Quick Actions from the DASHBOARD and
select “Submit Confidential e-filing” from the drop-down.

CALIFORNIA
ENERGY COMMISSION

GOV .
Dashboard Profile Clients Filings Help

Welcome Patty Paul
Submit e-filin
Your Recent e-filing Activity Submit Confidential e-fiing &
Showing the latest 25 results Add Client
N# + Date Docket # Project Title Document Title Visibility Status

a. To select a proceeding, enter a couple of characters and click on the
magnifying glass search icon. This search then lists all proceedings that include
the specified characters.

o Select Proceeding & Submitter

Step 1: Select a Proceeding & Add Submitter Info

Fields denoted by an asterisk (*) are required

- T,
Select a Proceeding 114 AFC‘

Docket #: 14-AFC-01
Submiter Inio | efifing Test Power Plant

In Review

Capacity: 5000 MW

Sacramenta County

Your Role in this Proceeding *

You will need to select a proceeding, a submitter, and your role in the proceeding before confinuing
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b. Alternatively, you may click on the View All Projects link and Select the
Proceeding at Issue.

Select a Proceeding

[~ Show expired, on hold, and suspended projects

Capacity
4 Docket # Project Title Status (MW) County

00-AFC-14C  El Segundo Power Redevelopment Project Under 630.000 Los
Compliance Construction Angeles

01-EP-14 CalPeak San Diego 49.5MW Peaking Power Operational 50.000 San Diego
Plant, San Diego, CA

01-EP-14C Calpeak Border Emergency Process - Operational San Diego Select
Compliance

14-AFC-01  €CeFiling Test Power Plant In Review 5000.000 Sam)“&m

c. Use the drop-down menu to select Your Role in this Proceeding.

Weicome Tiffani Winter | en

PROFILE CLIENTS FILINGS HELP

Submit a Confidential e-filing

n Select Proceeding & Submitter

Step 1: Select a Proceeding & Add Submitter Info

Fields denoted by an asterisk (*) are required.

Selecta Proceeding *  eFiling Test Power Plant Q

Submitter Info Update Submitter Info
Winter Solar Company
CA

Your Role in this Proceeding * |

will nee{Applicant Consultant ble in the proceedi
Applicant Representative

L 25
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d. If you choose a Representative or Consultant Role, you will also need to
Select a “Client”.

Submit a Confidential e-filing

o Select Proceeding & Submitter @ Upload Files @ Revi

Step 1: Select a Proceeding & Add Submitter Info

Fields denoted by an asterisk (*) are required.

(1]
®
Qo
w
U

Select a Proceeding * | eFiling Test Power Plant Q or View All Projects
Submitter Info Bil Jones , Update Submitter Info
Energy Analysis Corporation
CA
Your Role in this Proceeding * = Applicant Consultant j

@ Client* = ABC Powerplant, Sunny Solar, LLC Q or View A[I@

(071 (TR PR U/ LT3 Cancel and Retum to Previous Page

e. After you have selected the proceeding and your role, you can click on the
Continue to Upload Files button.

Weicome Tiffani Winter | energy.cagov | Logout

DASHBOARD PROFILE CLIENTS FILINGS

Submit a Confidential e-filing

Select Proceeding & Submitter

Step 1: Select a Proceeding & Add Submitter Info

Fields denoted by an asterisk (*) are required.

Selecta Proceeding* | eFiling Test Power Plant Q or View All Projects

Submitter Info
Winter Solar Company
CA

Your Role in this Proceeding * 3
Applicant

= Continue to Upload Files ancel and Return to Previous Page
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f. First you will upload your Application for a Confidential Designation by clicking on
the “Browse Button”. Maximum file size allowed is 30 MB’s.

Submit a Confidential e-filing

n Select Proceeding & Submitter E Upload Files < Revie

Step 2: Upload Your Documents

Fields denoted by an asterisk (*) are required

Select your Application for Confidential Designation

i i
Browse.. -

Upload and Continue

g. Hover over File Requirements to see acceptable file types and file size
requirements.

Submit a Confidential e-filing

=¥ File Requirements

| Maximum file size: 30 MB.

\Allowed file types: pdf, doc,

N
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h. Once you have selected your Application for Confidential Designation, Click the
Upload and Continue button.

Submit a Confidential e-filing

‘ n Select Proceeding & Submitter n Upload Files

Step 2: Upload Your Documents

Fields denoted by an asterisk (*) are required

Select your Application for Confidential Designation *
C \Documents and Settings\twinter\Desktop\Application for Cot| Browse.

Upload and Continue ™%

i. Next you will Select File(s) to Upload your confidential document(s). You can
upload multiple confidential documents.

Submit a Confidential e-filing

| € seclect Proceeding & Submitter © Upioad Files € Review s

Step 2: Upload Your Documents

Instructions

Select Files: Select the files you wish to upload by clicking the ‘Select File(s) to Upload' button. Multiple files can be selected by clicking the button again or, in certain

browsers, selecting multiple files. File drag and drop is also available in certain browsers. Note that file requirements apply

2. Upload Files: Once your files have been selected, they will appear in the 'Files Awaiting Upload" section. Click on the "Upload” button to transfer the files. Note that in
some cases, files may be automatically converted to Portable Document Format (PDF) once they are received.
For Mac users with IWork software, you can create a PDF file for upload by (1) selecting Print from the File menu; (2) clicking on Save as PDF... from the PDF drop
down menu; and (3) Glicking Save to save the PDF file on your computer.

3. Provide Details: After your files have been uploaded, they will appear in the ‘Uploaded Files' section. Edit the file details before continuing.

Note: Multiple documents uploaded within the same transaction will be given the same transaction number. If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements

or your document(s) will be rejected.
Documents uploaded after 5:00pm PST/PDT will be docketed on the next business day. Note that in some cases, filing deadlines may be set earlier than 5:00pm PST/PDT.

© File Requirements

Drop files here

ct file(s) to upload

Select File Afp— Please sel

Uploaded Files

for C D L ] G Edit details ® Remove file

application for confidential designation. pdf

You will need to edit details of the uploaded files before continuing. Cancel and Return to Previous Page

o e —
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j-  Once you have selected your confidential document(s), click on Upload File(s).

Step 2: Upload Your Doc

Instructions:

Select Files: Select the files you wish to upload by clicking the ‘Select File(s) to Upioad’ button. Muttiple files can be selected by clicking the button again or, in certain

browsers, selecting multiple files. File drag and drop is also available in certain browsers. Note that file requirements apply.

~

Upload Files: Once your fles have been selected, they will appear in the ‘Files Awaiting Uploadr section. Click on the ‘Upload’ button to transfer the files. Note that in
some cases, files may be automatically converted to Portable Document Format (PDF) ence they are received

For Mac users with Work software, you can create a PDF file for upload by (1) selecting Print from the File menu; (2) clicking on Save as PDF... from the PDF drop
down menu; and (3) Glicking Sava to save the PDF file on your computer

@

Provide Details: After your files have been uploaded, they will appear in the ‘Uploaded Files' section. Edit the file details before confinuing

Note: Multiple documents uploaded within the same transaction will be given the same transaction number. If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements
or your document(s) will be rejected.

Documents uploaded

r 5:00pm PST/POT will be docketed on the next business day. Note that in some cases, filing deadiines may be set eariier than 5:00pm PST/PDT

Drop files here

Select File — -

[ doc Z.docx .document) - 11.86 kb (pending)
[ ial doc 1.docx i iingml document) - 11.86 kb (pending)

Uploaded Files

Applicatior
3ppl

n for Confidential Designation Details Required JERg

details @ Re

You will need to edit details of the uploaded files before continuing.

k. You can upload as many separate proposed confidential documents by
repeating this same process.

***Please note: Password protected documents and zip file documents are not
accepted and will be rejected.

I.  The lock image indicates the file(s) are confidential.

2. Uploaded Files:

Step 2: Upload Your Documents

Instructions

Select Files: Select the files you wish lo upload by clicking the ‘Select File(s) to Upload button. Multipie files can be selected by clicking the bution again or, in certain
browsers, selecting multiple files. File drag and drop is also available in certain browsers. Note that file requirements apply.

Upload Files: Once your files have been selected, they will appear in the ‘Files Awaiting Upload” section. Glick on the ‘Upload bution 10 transfer the: fles. Note that in
some cases, files may be automatically converted to Porlable Document Format (PDF) ence they are received
For Mac users with Work software, you can create a PDF file for upload by (1) selecting Print from the File menu
down menu; and (3) Clicking Save fo save the PDF file-on your computer.

king on Save as PDF... from the PDF drop

3. Provide Details: After your files have been uploaded, they will appear in the ‘Uploaded Files' section. Edil the file details before conlinuing

Note: Multiple documents uploaded within the same transaction will be given the same transaction number, If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements
or your document(s) will be rejected.

Documents uploaded aier 5-00pm PST/PDT wil be docketed on the next business day. Note that in some cases, fling deadiines may be set earlier than 5:00pm PST/PDT

Drop files here

Select File F iegiffie(s) to upload

Uploaded Files

it detaids @ Remove fi

Applcation for Confidential Designation GE
appiication for Confids

al designation.pdf

You will need to edit details of the uploaded files before continuing C

vious
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a. Next you will need to provide details regarding your filings by clicking on Edit
Details.

b. Select Edit Details. The Update File Details screen will pop up. It is
important to fill out as many details as possible about the document because
these are the searchable metadata fields.

c. When populating the file details for the confidential data, you will need to input
a Confidentiality Sunset Date, expiration date or check the Indefinite box.
If you opt to check the Indefinite box, you will need to provide justification in
the Notes field.

Update File Details

Fields denoted by an asterisk (*) are required

) application for confidential designation.pdf
File Name

Title * Application for Confidential Designation

88 Character left out of 128

Document Descriplion

1024 Character left out of 1024

Subject(s) Cultural Resources x
select one or more
Claar Sealect All
Document Type Document el
Pages 4

Confidentiality Sunset Date *

=p [+/] Indefinite - Please provide justification in the Notes field

Addressed To CEC/Drew Bohan)| >
114 Character left out of 128

Notes

4l Update File Details Cancel

d. Once the fields are all populated, then click Update File Details. You will
need to do this for each document you file.
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e. Verify that you have uploaded all the files you wish to submit for docketing
and Click Continue to Review & Submit.

Step 2: Upload Your Documents

Instructions

1. Select Files: Select the files you wish to upload by clicking the 'Select File(s) fo Upload' butfon. Multiple files can be selected by clicking the button again or, in certain

browisers, selecting multiple files. File drag and drop is also available in certain browsers. Note that file requirements apply.

2. Upload Files: Once your files have been selected, they will appear in the 'Files Awaiting Upload' section. Click on the ‘Upload’ button to transfer the files. Note that in
some cases, files may be ticall ried to Portable D t Format (PDF) once they are received
For Mac users with iWork software, you can create a PDF file for upload by (1) selecting Print from the File menu; (2) clicking on Save as PDF... from the PDF drop
down menu; and (3) Clicking Save to save the PDF file on your computer.

3. Provide Details: After your files have been uploaded, they will appear in the ‘Uploaded Files' section. Edit the file details before continuing

Note: Multiple documents uploaded within the same transaction will be given the same transaction number. If documents should not be grouped, you will need to
file in separate sessions. All PDF documents need to be in searchable text format (optical character recognition (OCR) format) to comply with ADA requirements

or your document(s) will be rejected.

Documents uploaded after 5:00pm PST/PDT will be docketed on the next business day. Note that in some cases, filing deadlines may be set earlier than 5:00pm PST/PDT

© File Requirements

Drop files here

i Please select file(s) to upload
elect File

Uploaded Files

Application for Confidential Designation m (7 Edit details () Remove file
application for confidential designation.pdf

i Confidential doc 1.pdf m (& Edit details (® Remove file
i Confidential doc 2.pdf m (& Edit details (5) Remove file

el and Return fo Previous Page

Continue to Review & Submit
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f. Review your filing to ensure accuracy and click on | Agree & Submit. If your
file is not ready to submit, you can still use the Edit Details, Remove File and
Cancel and Return to Previous Page Links.

Step 3: Review Your e-filing

Your Filing

. Edit
14-AFC-01 eFiling Test Power Plant California Energy Commission

Your Documents

Document # 1 - Application for Confidential Designation (z Edit details ) Remove file
Titie: Application for Confidential Designati
Document Description:

Filename: application for confidential designation. pdf
4 page(s)

Subject(s)

Document Type: Document

Notes to CEC

& Document #2 @ Edit details @ Remove file
Title: Confidential Document One
Document Description:

p

Filename: Confidential doc 1.pdf
12 page(s)

Subject(s): Cultural Resources
Document Type: Document
Notes to CEC

# Document # 3 & Edit details @ Remove file
Title: Confidential Document Two

Document Description:

Filename: Confidential doc 2 pdf

2 page(s)

Subject(s): Biological Resources

Document Type: Document

Notes to CEC

[ This docket may be set to group filings made within a certain period together to reduce the number of e-mails that parties
and listserv subscribers receive. Check this box to request that your document(s) be distributed immediately after approval
for filing

| certify under penalty of perjury under the laws of the State of California that on this date |

1. am legally authorized to submit the accompanying comments or documents,

2. have received any required licenses with respect to any copyrights or trademarks applicable to the accompanying
documents,

3. have determined that the accompanying documents comply with the Energy Commission’s guidelines for
appropriate submissions, and

4. understand that unless my written request for confidentiality has been approved under California Code of
Regulations, title 20, section 2505, my written and oral comments, filings (including the accompanying documents),
and associated contact information (e.g. address, phone, email, etc.) will become part of the viewable public record
and may become publicly available via Google, Yahoo, and any other internet search engines.

For more information about the Commission's procedures for applications for confidentiality, please contact the Chief
Counsel's Office at (918) 654-3051. For the instructions and form for requesting a document be given confidential status,

n/chief counseldocuments/CEC13.pdf

‘ I Aaree & Submit b

see hitp/hww2 energy.ca.gov/comm

ncel and RE:_L..'TI to Previous Page
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3. Upon successful submission of the files, the system will provide an onscreen
message. Next, click Continue.

e-filing Submission Complete

Your e-filing was submitted successfully, and will be reviewed by the California Energy C on before it is published to the Docket. You will receive an e-mail confirmation
regarding this submission

Once the Califomia Energy Commission reviews your e-filing, another e-mail will be sent to you notifying you about the publishing status of your e-filing

gl Continue

Thank you

a. When you click on the Continue button, you will be redirected to the
Dashboard. A green highlighting, a message confirming your filing will be
displayed. Your filing will also show up in Your Recent Filing e-filing Activity
list.

[ /Y
Dashboard Profile ‘ Clients Filings Help

* Your e-filing was submitted successfully. An e-mail has been sent to you confirming your submission.

Welcome RétynFauPublic

Your Recent e-filing Activity

Showing the latest 25 results

TN# ¥ Date Docket # Project Title Document Title Visibility Status

9/16/2019 14-AFC-01 eFiling Test Power Plant Confidential Document Two Confidential Pending
Biological Resources
k& 2 page(s)

9/16/2019 14-AFC-01 eFiling Test Power Plant Confidential Document One Confidential ~ Pending
Cultural Resources
ki 12 page(s)

9/16/2019 14-AFC-01 eFiling Test Power Plant Application for Confidential Designation Confidential Pending
ki 4 page(s)
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b. The system will also send a confirming email notification to your registered
email address.

Dear John Q. Public

Your 3 confidential e-filing(s) were successfully submitted to Docket Number 14-AFC-01, and will be
reviewed by the Docket Unit.

The following file(s) were submitted:

Title: Application for Confidential Designation
4 page(s)
Document Type: Document

Title: Confidential Document One
12 page(s)
Subject(s): Cultural Resources
Document Type: Document

Title: Confidential Document Two
2 page(s)
Subject(s): Biological Resources
Document Type: Document

Another e-mail will communicate the results of the Docket Unit’s review.

Thank you.
09/16/2019 10:41:39.407

4. If the Docket Unit Staff approves your application, you will receive two
confirming emails. The first email will have a link to the docketed application. The
second email will be confirming that your confidential data is being reviewed.

Dear John Q. Public,

Your 2 confidential filing(s) submitted on 9/16/2019 11:55:55 AM, to Docket Number 14-AFC-01,
have been approved by Dockets staff.

The Application for Confidential Designation associated with your filing(s) has been published to
the California Energy Commission website:

The following other document(s) included in your confidential filing are now awaiting
confidentiality review:

. Title: Confidential Document One
12 page(s)

. Title: Confidential Document Two
2 page(s)

You will be notified again as to the status of your confidential filing(s) once the confidentiality
review is complete.
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a. After the Docket Unit Staff “Approves” the application, the confidential

document(s) will be forwarded to the Confidentiality Attorney for review before
they are entered into the respective docket.

5. If the Docket Unit staff “Rejects” the Application for Confidentiality, the entire filing
will be removed from the system, and you will receive an email reflecting the
reason for the rejection as shown below:

Your 3 confidential filing(s) rejected.

Dear John Q. Public,

Your 3 confidential filing(s) submitted on 9/16/2019 9:18:30 AM, to Docket Number 14-AFC-01, have been
rejected by the California Energy Commission.

The reason for rejection is:

* no data was submitted with your application

] Creating a PDF

1. To save your work as a PDF in Microsoft Word, Google Docs, Apple Pages, or
other word processors involves pretty much the same steps:

000 CTo

Open the document you want to save as a PDF.

Click on the File tab.

In Word, click Save As | PDF from the drop-down menu.

In Google Docs, click File | Download | PDF.

In Pages, it’s File | Export to | PDF.

In the file name box, .pdf will automatically appear at the end of your file
name.

2. You can save a document as a PDF by clicking File | Print. An option for Print
Preview will appear.

a.

b.

Under Printer, change it from your computer printer, such as Epson, Canon,
or HP, to PDF.
Click Print and it will save the file as a PDF on your computer.

\") Making a PDF Searchable

1. Using Adobe:

a.
b.
C.

d.

Open Adobe Acrobat/Adobe Acrobat Pro on your computer.

Click Open.

Find and select the document you want to make searchable, then click
Open.

Head to Tools and select Recognize Text.
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e.

f.

g.

Press PDF Output Style Searchable Image.
Select OK.
You can search the web/internet for other options.

Vv Checking to make sure a PDF is Searchable

1. Making sure your PDF is searchable.

a.

oo

After opening the PDF, try searching for a word known to be in the document
(preferably a word that appears on several different pages) by clicking CTRL-
F and entering the word in the Find box.

If text highlights, it is searchable.

Open the PDF in Adobe Acrobat,

then select the "Edit" menu > "Select All". This will select all of the text in the
file.

If nothing is selected, there is no text, and the file isn't searchable.
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